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How	to	paste	text	in	pdf

Copying	text	from	one	location	and	pasting	it	into	the	CMS	can	be	very	helpful.	If	your	moving	a	site	from	the	old	system	to	the	new,	or	if	you	like	to	type	all	of	your	content	into	a	program	like	Microsoft	Word	before	putting	it	in	the	CMS,	copying	and	pasting	as	plain	text	will	save	you	from	having	to	retype	all	of	your	content	due	to	other	code	and
formatting	from	your	source	document.	If	you	copy	and	paste	directly	from	a	program	like	word	you	could	end	up	copying	and	pasting	formatting	that	will	ruin	the	look	of	your	site.	Here's	how	to	correctly	copy	and	paste	text	into	the	CMS.	Copy	and	paste	text	from	any	source	into	the	CMS	Highlight	the	text	that	you	want	to	copy	and	either	right	click
and	select	Copy	or	hit	the	Control/Command	and	C	keys	on	your	keyboard.	Before	pasting	text	into	the	text	editor	of	the	CMS,	make	sure	you	paste	it	as	text	only.	Click	Edit,	Paste	as	text	to	ensure	other	formatting	isn't	copied	into	your	page			Add	text	to	a	document	by	typing	or	by	pasting	or	placing	text	from	a	word-processing	application.	If	your
word-processing	application	supports	drag-and-drop,	you	can	also	drag	text	into	InDesign	frames.	For	large	blocks	of	text,	the	Place	command	is	an	efficient,	versatile	way	to	add	text	to	your	document.	InDesign	supports	a	variety	of	word-processing,	spreadsheet,	and	text	file	formats.	When	you	place	or	paste	text,	you	do	not	need	to	create	a	text
frame	first;	InDesign	will	create	one	for	you	automatically.	When	you	place	text,	you	can	select	Show	Import	Options	to	determine	whether	the	imported	text	maintains	its	styles	and	formatting.	Before	you	paste	text,	you	can	select	All	Information	or	Text	Only	under	Clipboard	Handling	Preferences	to	determine	whether	the	pasted	text	includes
additional	information	such	as	swatches	and	styles.	If	the	text	you	import	into	your	document	includes	pink,	green,	or	another	color	of	highlighting,	you	likely	have	one	or	more	composition	preference	options	turned	on.	Open	the	Composition	section	of	the	Preferences	dialog	box,	and	notice	which	options	are	turned	on	under	Highlight.	For	example,
if	the	pasted	text	is	formatted	with	fonts	not	available,	the	text	is	highlighted	in	pink.	To	place	the	insertion	point	inside	the	text	frame,	do	one	of	the	following:	Using	the	Type	tool	,	drag	to	create	a	new	text	frame,	or	click	in	an	existing	text	frame.	Using	a	selection	tool,	double-click	inside	an	existing	text	frame.	The	Type	tool	is	selected	automatically.
If	you	created	a	text	frame	on	a	master	page,	hold	down	Ctrl+Shift	(Windows)	or	Command+Shift	(Mac	OS)	as	you	click	in	the	frame	on	your	document	page.	This	makes	a	copy	of	the	master	page	frame	on	the	document	page.	You	can	then	use	the	Type	tool	to	add	text	to	the	selected	frame.	Type	Asian	text	using	inline	input	Choose	Edit	>
Preferences	>	Advanced	Type	(Windows)	or	InDesign	>	Preferences	>	Advanced	Type	(Mac	OS).	Select	Use	Inline	Input	For	Non-Latin	Text,	and	then	click	OK.	You	can	use	a	system	input	method,	if	available,	for	adding	2‑byte	and	4‑byte	characters.	This	method	is	especially	useful	for	entering	Asian	characters.	InDesign	can	add	placeholder	text	that
you	can	easily	replace	with	real	text	later.	Adding	placeholder	text	can	give	you	a	more	complete	sense	of	your	document’s	design.	Use	the	Selection	tool	to	select	one	or	more	text	frames,	or	use	the	Type	tool	to	click	in	a	text	frame.	Choose	Type	>	Fill	With	Placeholder	Text.	If	you	add	placeholder	text	to	a	frame	that’s	threaded	to	other	frames,	the
placeholder	text	is	added	at	the	start	of	the	first	text	frame	(if	all	frames	are	empty)	or	at	the	end	of	the	existing	text	(if	some	text	is	already	in	the	threaded	frames),	through	to	the	end	of	the	last	threaded	frame.	To	remove	or	replace	placeholder	text,	double-click	in	any	frame	in	the	thread,	choose	Edit	>	Select	All,	and	then	delete	the	text.	To	change
the	text	that	is	used	as	placeholder	text,	create	a	text	file	with	the	text	you	wish	to	use,	name	it	Placeholder.txt,	and	save	it	in	the	application	folder.	If	the	insertion	point	is	not	inside	a	text	frame	when	you	paste	text	into	InDesign,	a	new	plain	text	frame	will	be	created.	If	the	insertion	point	is	inside	a	text	frame,	the	text	will	be	pasted	inside	that
frame.	If	you	have	text	selected	when	you	paste,	the	pasted	text	will	overwrite	the	selected	text.	Paste	text	from	another	application	To	preserve	formatting	and	information	such	as	styles	and	index	markers,	open	the	Clipboard	Handling	section	of	the	Preferences	dialog	box,	and	select	All	Information	under	Paste.	To	remove	these	items	and	other
formatting	when	pasting,	select	Text	Only.	Cut	or	copy	text	in	another	application	or	in	an	InDesign	document.	If	you	like,	select	text	or	click	in	a	text	frame.	Otherwise,	the	text	will	be	pasted	into	its	own	new	frame.	Choose	Edit	>	Paste.	If	the	pasted	text	doesn’t	include	all	the	formatting,	you	may	need	to	change	settings	in	the	Import	Options	dialog
box	for	RTF	documents.	Choose	Edit	>	Paste	Without	Formatting.	(Paste	Without	Formatting	is	dimmed	if	you	paste	text	from	another	application	when	Text	Only	is	selected	in	Clipboard	Handling	Preferences.)	You	can	also	drag	text	from	another	application	and	drop	it	into	an	InDesign	document,	or	you	can	insert	a	text	file	or	word-processing	file
into	an	InDesign	document	directly	from	Windows	Explorer	or	Mac	OS	Finder.	The	text	will	be	added	to	a	new	frame.	Shift-dragging	removes	the	formatting.	The	option	you	select	in	the	Clipboard	Handling	section	of	the	Preferences	dialog	box	determines	whether	information	such	as	index	markers	and	swatches	is	preserved.	Adjust	spacing
automatically	when	pasting	text	When	you	paste	text,	spaces	can	be	automatically	added	or	removed,	depending	on	the	context.	For	example,	if	you	cut	a	word	and	then	paste	it	between	two	words,	a	space	appears	before	and	after	the	word.	If	you	paste	that	word	at	the	end	of	a	sentence,	before	the	period,	a	space	is	not	added.	This	feature	is	used
primarily	for	working	with	Roman	text.	Also,	this	feature	is	available	only	when	the	Roman	text	to	be	pasted	is	set	to	a	Roman	language	in	the	Character	panel.	Choose	Edit	>	Preferences	>	Type	(Windows)	or	InDesign	>	Preferences	>	Type	(Mac	OS).	Select	Adjust	Spacing	Automatically	When	Cutting	And	Pasting	Words,	and	then	click	OK.	You	can
use	the	mouse	to	drag	and	drop	text	in	the	Story	Editor	or	in	the	Layout	View.	You	can	even	drag	text	from	the	Story	Editor	to	the	layout	window	(or	vice	versa),	or	into	some	dialog	boxes	such	as	Find/Change.	Dragging	the	text	from	a	locked	or	checked-in	story	copies	the	text	rather	than	moves	it.	You	can	also	copy	text	or	create	a	new	frame	when
dragging	and	dropping	text.	Jeff	Witchel	provides	a	video	tutorial	about	drag	and	drop	at	Using	InDesign	Drag	and	Drop	Text.	To	enable	drag	and	drop,	choose	Edit	>	Preferences	>	Type	(Windows)	or	InDesign	>	Preferences	>	Type	(Mac	OS),	select	Enable	In	Layout	View,	Enable	In	Story	Editor	(InDesign),	or	Enable	In	Galley/Story	View	(InCopy),
and	then	click	OK.	Select	the	text	that	you	want	to	move	or	copy.	Hold	the	pointer	over	the	selected	text	until	the	drag	and	drop	icon		appears,	and	then	drag	the	text.	As	you	drag,	the	selected	text	remains	in	place,	but	a	vertical	bar	indicates	where	the	text	will	appear	when	you	release	the	mouse	button.	The	vertical	bar	appears	in	any	text	frame
that	you	drag	the	mouse	over.	To	drop	the	text	in	a	new	location,	position	the	vertical	bar	where	you	would	like	the	text	to	appear	and	release	the	mouse	button.	To	drop	the	text	in	a	new	frame,	hold	down	Ctrl	(Windows)	or	Command	(Mac	OS)	after	you	start	dragging,	and	then	release	the	mouse	button	before	releasing	the	key.	To	drop	the	text
without	formatting,	hold	down	Shift	after	you	start	dragging,	and	then	release	the	mouse	button	before	releasing	the	key.	To	copy	the	text,	hold	down	Alt	(Windows)	or	Option	(Mac	OS)	after	you	start	dragging,	and	then	release	the	mouse	button	before	releasing	the	key.	You	can	also	use	a	combination	of	these	modifier	keys.	For	example,	to	copy
unformatted	text	to	a	new	frame,	hold	down	Alt+Shift+Ctrl	(Windows)	or	Option+Shift+Command	(Mac	OS)	after	you	start	dragging.	If	the	text	you	drop	doesn’t	have	the	proper	spacing,	select	the	Adjust	Spacing	Automatically	option	in	Type	Preferences.	When	you	place	a	text	or	spreadsheet	file,	you	can	specify	options	to	determine	how	the
imported	text	is	formatted.	(Optional)	To	create	links	to	the	files	being	placed,	click	File	Handling	in	the	Preferences	dialog	box	and	select	Create	Links	When	Placing	Text	And	Spreadsheet	Files.	Selecting	this	option	creates	a	link	to	the	placed	file.	You	can	use	the	Links	panel	to	update,	relink,	or	remove	links	to	text	files.	However,	if	you	format
linked	text	in	InDesign,	the	formatting	may	not	be	preserved	when	you	update	the	link.	If	this	option	isn’t	selected,	imported	text	and	spreadsheet	files	are	embedded	(not	linked).	To	create	a	new	frame	for	the	placed	text,	make	sure	that	no	insertion	point	is	present	and	that	no	text	or	frames	are	selected.	To	add	text	to	a	frame,	use	the	Type	tool		to
select	text	or	place	the	insertion	point.	To	replace	the	contents	of	an	existing	frame,	use	a	selection	tool	to	select	the	frame.	If	the	frame	is	threaded,	a	loaded	text	cursor	appears.	If	you	accidentally	replace	a	text	file	or	graphic	using	this	method,	choose	Edit	>	Undo	Replace,	and	then	click	or	drag	to	create	a	text	frame.	Select	Replace	Selected	Item
if	you	want	the	imported	file	to	replace	the	contents	of	a	selected	frame,	to	replace	selected	text,	or	to	be	added	to	the	text	frame	at	the	insertion	point.	Deselect	this	option	to	flow	the	imported	file	into	a	new	frame.	Select	Show	Import	Options,	and	then	double-click	the	file	you	want	to	import.	Set	import	options,	and	then	click	OK.	If	you	haven’t
already	designated	an	existing	frame	to	receive	text,	the	pointer	becomes	a	loaded	text	icon,	ready	to	flow	text	wherever	you	click	or	drag.	The	placed	text	frame	can	be	converted	into	either	a	plain	text	frame	or	a	frame	grid,	depending	on	the	settings	in	the	Story	panel.	You	can	choose	Type	>	Writing	Direction	>	Horizontal	or	Vertical	to	determine
the	frame’s	writing	direction.	When	text	is	placed	in	a	frame	grid,	the	document	defaults	set	in	the	Grid	tool	apply	to	the	frame	grid.	Apply	grid	formatting	as	necessary.	If	you	receive	an	alert	that	the	requested	filter	wasn’t	found,	you	may	be	trying	to	place	a	file	from	a	different	word-processing	application	or	from	an	earlier	version	of	Microsoft®
Word,	such	as	Word	6.	Open	the	file	in	its	original	application	and	save	it	as	RTF,	which	preserves	most	formatting.	If	the	imported	Microsoft	Excel	document	displays	red	dots	in	cells,	adjust	cell	size	or	text	attributes	so	that	overset	content	becomes	visible.	You	can	also	place	the	file	as	unformatted	tabbed	text,	and	then	convert	the	tabbed	text	to	a
table.	InDesign	imports	most	character	and	paragraph	formatting	attributes	from	text	files	but	ignores	most	page-layout	information,	such	as	margin	and	column	settings	(which	you	can	set	in	InDesign).	Note	the	following:	InDesign	generally	imports	all	formatting	information	specified	in	the	word-processing	application,	except	information	for	word-
processing	features	not	available	in	InDesign.	InDesign	can	add	imported	styles	to	its	list	of	styles	for	the	document.	A	disk	icon	appears	next	to	imported	styles.	(See	Convert	Word	styles	to	InDesign	styles.)	The	import	options	appear	when	you	select	Show	Import	Options	in	the	Place	dialog	box,	or	when	you	import	an	Excel	file.	If	Show	Import
Options	is	deselected,	InDesign	uses	the	import	options	last	used	for	a	similar	document	type.	The	options	you	set	remain	in	effect	until	you	change	them.	If	InDesign	cannot	find	a	filter	that	recognizes	a	file	by	either	its	file	type	or	file	extension,	an	alert	message	appears.	For	best	results	in	Windows,	use	the	standard	extension	(such	as	.doc,	.docx,
.txt,	.rtf,	.xls,	or	.xlsx)	for	the	type	of	file	you’re	importing.	You	may	need	to	open	the	file	in	its	original	application	and	save	it	in	a	different	format,	such	as	RTF	or	text-only.	For	more	information	on	import	filters,	see	the	Filters	ReadMe	PDF	file	at	www.adobe.com/go/lr_indesignfilters_cs5_en.	Microsoft	Word	and	RTF	import	options	If	you	select	Show
Import	Options	when	placing	a	Word	file	or	an	RTF	file,	you	can	choose	from	these	options:	Imports	the	table	of	contents	as	part	of	the	text	in	the	story.	These	entries	are	imported	as	text	only.	Imports	the	index	as	part	of	the	text	in	the	story.	These	entries	are	imported	as	text	only.	Imports	Word	footnotes.	Footnotes	and	references	are	preserved,	but
renumbered	based	on	the	document’s	footnote	settings.	If	the	Word	footnotes	are	not	imported	properly,	try	saving	the	Word	document	in	RTF	format	and	importing	the	RTF	file.	Imports	endnotes	as	part	of	the	text	at	the	end	of	the	story.	Ensures	that	imported	text	includes	left	and	right	quotation	marks	(“	”)	and	apostrophes	(’)	instead	of	straight
quotation	marks	("	")	and	apostrophes	(').	Remove	Styles	And	Formatting	From	Text	And	Tables	Removes	formatting,	such	as	typeface,	type	color,	and	type	style,	from	the	imported	text,	including	text	in	tables.	Paragraph	styles	and	inline	graphics	aren’t	imported	if	this	option	is	selected.	When	you	choose	to	remove	styles	and	formatting	from	text	and
tables,	you	can	select	Preserve	Local	Overrides	to	maintain	character	formatting,	such	as	bold	and	italics,	that	is	applied	to	part	of	a	paragraph.	Deselect	this	option	to	remove	all	formatting.	When	you	choose	to	remove	styles	and	formatting	from	text	and	tables,	you	can	convert	tables	to	either	basic,	unformatted	tables	or	unformatted,	tab-delimited
text.	If	you	want	to	import	unformatted	text	and	formatted	tables,	import	the	text	without	formatting,	and	then	paste	the	tables	from	Word	into	InDesign.	Preserve	Styles	And	Formatting	From	Text	And	Tables	Preserves	the	Word	document’s	formatting	in	the	InDesign	or	InCopy	document.	You	can	use	the	other	options	in	the	Formatting	section	to
determine	how	styles	and	formatting	are	preserved.	Determines	how	page	breaks	from	the	Word	file	are	formatted	in	InDesign	or	InCopy.	Select	Preserve	Page	Breaks	to	use	the	same	page	breaks	used	in	Word,	or	select	Convert	To	Column	Breaks	or	No	Breaks.	Preserves	inline	graphics	from	the	Word	document	in	InDesign.	Imports	all	styles	from
the	Word	document,	even	if	the	styles	aren’t	applied	to	text.	Convert	Bullets	&	Numbers	To	Text	Imports	bullets	and	numbers	as	actual	characters,	preserving	the	look	of	the	paragraph.	However,	in	numbered	lists,	the	numbers	are	not	automatically	updated	when	the	list	items	are	changed.	Selecting	this	option	causes	Track	Changes	markups	from
the	Word	document	to	appear	in	the	InDesign	document.	In	InDesign,	view	track	changes	in	Story	Editor.	Import	Styles	Automatically	Imports	styles	from	the	Word	document	into	the	InDesign	or	InCopy	document.	If	a	yellow	warning	triangle	appears	next	to	Style	Name	Conflicts,	then	one	or	more	paragraph	or	character	styles	from	the	Word
document	have	the	same	name	as	an	InDesign	style.	To	determine	how	these	style	name	conflicts	are	resolved,	select	an	option	from	the	Paragraph	Style	Conflicts	and	Character	Style	Conflicts	menu.	Choosing	Use	InDesign	Style	Definition	causes	the	imported	style	text	to	be	formatted	based	on	the	InDesign	style.	Choosing	Redefine	InDesign	Style
causes	the	imported	style	text	to	be	formatted	based	on	the	Word	style,	and	changes	existing	InDesign	text	formatted	with	the	Word	style.	Choosing	Auto	Rename	causes	the	imported	Word	styles	to	be	renamed.	For	example,	if	InDesign	and	Word	have	a	Subheading	style,	the	imported	Word	style	is	renamed	Subheading_wrd_1	when	Auto	Rename	is
selected.	InDesign	converts	paragraph	and	character	styles	but	not	bulleted	and	numbered	list	styles.			Lets	you	use	the	Style	Mapping	dialog	box	to	select	which	InDesign	style	should	be	used	for	each	Word	style	in	the	imported	document.	Stores	the	current	Word	Import	Options	for	later	reuse.	Specify	the	import	options,	click	Save	Preset,	type	the
name	of	the	preset,	and	click	OK.	The	next	time	you	import	a	Word	style,	you	can	select	the	preset	you	created	from	the	Preset	menu.	Click	Set	As	Default	if	you	want	the	selected	preset	to	be	used	as	the	default	for	future	imports	of	Word	documents.	If	you	select	Show	Import	Options	when	placing	a	text	file,	you	can	choose	from	these	options:
Specifies	the	computer	language	character	set,	such	as	ANSI,	Unicode	UTF8,	or	Windows	CE,	that	was	used	to	create	the	text	file.	The	default	selection	is	the	character	set	that	corresponds	to	the	default	language	and	platform	of	InDesign	or	InCopy.	Specifies	the	computer	language	character	set,	such	as	ANSI,	Unicode	UTF8,	Shift	JIS,	or	Chinese
Big	5,	that	was	used	to	create	the	text	file.	The	default	selection	is	the	character	set	that	corresponds	to	the	default	language	and	platform	of	InDesign	or	InCopy.	Specifies	whether	the	file	was	created	in	Windows	or	Mac	OS.	Specifies	the	dictionary	to	be	used	by	the	imported	text.	Specifies	how	extra	paragraph	returns	are	imported.	Choose	Remove
At	End	Of	Every	Line	or	Remove	Between	Paragraphs.	Replaces	the	specified	number	of	spaces	with	a	tab.	Ensures	that	imported	text	includes	left	and	right	quotation	marks	(“	”)	and	apostrophes	(’)	instead	of	straight	quotation	marks	("	")	and	apostrophes	(').	Microsoft	Excel	import	options	You	can	choose	from	these	options	when	importing	an	Excel
file:	Specifies	the	worksheet	you	want	to	import.	Specifies	whether	to	import	any	stored	custom	or	personal	views,	or	to	ignore	the	views.	Specifies	the	range	of	cells,	using	a	colon	(:)	to	designate	the	range	(such	as	A1:G15).	If	there	are	named	ranges	within	the	worksheet,	these	names	appear	in	the	Cell	Range	menu.	Import	Hidden	Cells	Not	Saved
In	View	Includes	any	cells	formatted	as	hidden	cells	in	the	Excel	spreadsheet.	Specifies	how	the	spreadsheet	information	appears	in	the	document.	InDesign	tries	to	preserve	the	same	formatting	used	in	Excel,	although	the	formatting	of	text	within	each	cell	may	not	be	preserved.	If	the	spreadsheet	is	linked	rather	than	embedded,	updating	the	link
will	override	any	formatting	applied	to	the	table	in	InDesign.	The	table	is	imported	without	any	formatting	from	the	spreadsheet.	When	this	option	is	selected,	you	can	apply	a	table	style	to	the	imported	table.	If	you	format	text	using	paragraph	and	characters	styles,	the	formatting	is	preserved	even	if	you	update	the	link	to	the	spreadsheet.	The	table	is
imported	as	tab-delimited	text,	which	you	can	then	convert	to	a	table	in	InDesign	or	InCopy.	InDesign	preserves	the	same	formatting	used	in	Excel	during	the	initial	import.	If	the	spreadsheet	is	linked	rather	than	embedded,	formatting	changes	made	to	the	spreadsheet	are	ignored	in	the	linked	table	when	you	update	the	link.	This	option	isn’t
available	in	InCopy.	Applies	the	table	style	you	specify	to	the	imported	document.	This	option	is	available	only	if	Unformatted	Table	is	selected.	Specifies	the	cell	alignment	for	the	imported	document.	Preserves	inline	graphics	from	the	Excel	document	in	InDesign.	Number	Of	Decimal	Places	To	Include	Specifies	the	number	of	decimal	places	of
spreadsheet	figures.	Ensures	that	imported	text	includes	left	and	right	quotation	marks	(“	”)	and	apostrophes	(’)	instead	of	straight	quotation	marks	("	")	and	apostrophes	(').	Tagged-text	import	options	You	can	import	(or	export)	a	text	file	capable	of	taking	advantage	of	InDesign	formatting	capabilities	by	using	the	tagged	text	format.	Tagged-text	files
are	text	files	containing	information	describing	the	formatting	you	want	InDesign	to	apply.	Properly	tagged	text	can	describe	almost	anything	that	can	appear	in	an	InDesign	story,	including	all	paragraph-level	attributes,	character-level	attributes,	and	special	characters.	For	information	on	specifying	tags,	view	the	Tagged	Text	PDF	at
www.adobe.com/go/learn_id_taggedtext_cs5_en	(PDF).	The	following	options	are	available	when	you	import	a	tagged-text	file	and	select	Show	Import	Options	in	the	Place	dialog	box.	Ensures	that	imported	text	includes	left	and	right	quotation	marks	(“	”)	and	apostrophes	(’)	instead	of	straight	quotation	marks	("	")	and	apostrophes	(').	Removes
formatting,	such	as	typeface,	type	color,	and	type	style,	from	the	imported	text.	Resolve	Text	Style	Conflicts	Using	Specifies	which	character	or	paragraph	style	to	apply	when	there	is	a	conflict	between	the	style	in	the	tagged-text	file	and	the	style	in	the	InDesign	document.	Select	Publication	Definition	to	use	the	definition	that	already	exists	for	that
style	in	the	InDesign	document.	Select	Tagged	File	Definition	to	use	the	style	as	defined	in	the	tagged	text.	Show	List	Of	Problem	Tags	Before	Place	Displays	a	list	of	unrecognized	tags.	If	a	list	appears,	you	can	choose	to	cancel	or	continue	the	import.	If	you	continue,	the	file	may	not	look	as	expected.	Save	Word	or	RTF	import	options	as	presets	When
placing	a	Word	or	RTF	file,	make	sure	that	Show	Import	Options	is	selected,	and	choose	Open.	In	the	Import	Options	dialog	box,	specify	the	desired	settings.	Click	Save	Preset,	type	a	preset	name,	and	click	OK.	(Optional)	Click	Set	As	Default	to	use	the	preset	each	time	you	import	a	file	of	that	file	type.	You	can	then	select	custom	presets	from	the
Preset	menu	in	the	Import	Options	dialog	box	whenever	you	open	a	Word	or	RTF	file.	Import	Buzzword	documents	Buzzword	is	a	web-based	text	editor	that	lets	users	create	and	store	text	files	on	a	web	server.	In	InDesign	CS5,	you	can	import	and	export	text	from	Buzzword	documents.	When	you	import	a	Buzzword	document,	a	URL-based	link	is
created	to	the	Buzzword	document	on	the	server.	When	the	Buzzword	document	is	updated	outside	InDesign,	you	can	use	the	Links	panel	to	update	the	imported	version	in	InDesign.	However,	doing	so	removes	any	changes	to	the	Buzzword	text	you’ve	made	in	InDesign.	The	Acrobat.com	Buzzword	application	is	available	only	in	English,	French,	and
German.	Choose	File	>	Place	From	Buzzword.	If	you	haven’t	already	signed	in	to	CS	Live,	click	Sign	In,	specify	your	e-mail	address	and	password,	and	then	click	Sign	In.	Once	you	sign	in,	the	Place	Buzzword	Documents	dialog	box	displays	a	list	of	the	Buzzword	documents	you	can	import.	Select	one	or	more	documents	you	want	to	import,	or	paste
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document	and	the	placed	text.	If	you	establish	a	link	and	update	the	Buzzword	document,	the	Links	panel	indicates	that	the	file	has	been	modified.	If	you	update	the	link,	the	text	in	InDesign	is	updated.	However,	formatting	changes	you’ve	made	to	this	text	in	InDesign	are	lost.	If	you	selected	Show	Import	Options,	specify	settings	in	the	Buzzword
Import	Options	dialog	box.	This	dialog	box	includes	most	of	the	same	options	found	in	the	RTF	Import	Options	dialog	box.	See	Microsoft	Word	and	RTF	import	options.	Buzzword	currently	does	not	have	a	styles	feature,	so	none	of	the	style	options	are	valid	at	this	time.	With	the	loaded	text	cursor,	click	or	drag	to	create	a	text	frame.	Link	or	embed
imported	text	files	By	default,	text	you	place	in	InDesign	is	not	linked	to	the	original	text	file.	However,	if	you	select	the	Create	Links	When	Placing	Text	And	Spreadsheet	Files	option	in	File	Handling	preferences	before	you	place	a	file,	the	name	of	the	text	file	appears	in	the	Links	panel.	You	can	use	the	Links	panel	to	update	and	manage	the	file.
When	you	update	a	linked	text	file,	any	editing	or	formatting	changes	applied	within	InDesign	are	lost.	Because	of	this	risk,	linked	text	files	are	not	automatically	updated	when	the	original	file	is	edited.	However,	you	can	easily	use	the	Links	panel	to	update	content	or	to	unlink	(embed)	the	file.	To	apply	this	change	to	a	document,	open	the	document.
To	apply	this	change	to	any	new	document	you	create,	close	all	documents.	Choose	Edit	>	Preferences	>	File	Handling	(Windows)	or	InDesign	>	Preferences	>	File	Handling	(Mac	OS).	To	create	links	in	placed	files,	select	Create	Links	When	Placing	Text	And	Spreadsheet	Files.	If	this	option	is	turned	on,	use	the	Links	panel	to	update,	relink,	or
remove	links.	If	this	option	is	turned	off,	text	files	are	embedded	(not	linked).	To	unlink	(embed)	a	linked	text	file,	select	the	file	in	the	Links	panel,	and	then	choose	Unlink	from	the	Links	panel	menu.
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